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How does a fold + staple book work? Pages are printed in

spreads of 2: Page count
Standard fold + staple books have
4 pages on each sheet of paper

_I |__ (2 on the front, and 2 on the back)

Here are two
sheets of paper,
with book pages
printed in a
shuffled order.

Maximum page count depends
on the weight of the paper, but
48 pages is usually around the
thickest that can be stapled.

This book is 12 pages long:
— — 3 sheets of paper, double sided

Each page gets

folded in half... BOOK FOLDED

PAGES SHEETS

The book's total page
e 2 [

count needs to be a

multiple of 4: 12 3 M
2 pages per side 16 4 m ..........

+ 2 sides per sheet 20 2 m ,,,,,,,,,,

= 4 pages per 2 © m ..........

...and when the sheets fold together,
the matching page spreads line up.
The book should now be in the
correct reading order.

The pages are usually held together

with staples, but it’s also possible to: sheet of paper 28 7
» use other methods to bind a
folded spine together (for Covers 32 8
example, sewing it
ith th )
with thread or string) Include the covers in the page 36 9

« make a folding design that either
doesn’t need anything holding it
together, or intentionally splits into

count if the book will all be printed
together on the same paper.

40 10

Count the covers separately if the

loose pieces.
P! inside pages and covers will be
printed on different papers. A book 44 1"
project like this can be described as
the page count "plus covers", as in: 48 12
\Z

"16 pages + covers"



Planning for paper Printing at School

Printer Margins

A folding book needs to be printed on
sheets of paper big enough for:

Self-Serve Laser Printing

None of the school printers can print all the way to the edge of the paper,
card readers and you can expect to lose around 0.25" (6mm) on each side...but not exactly
the same on all 4 sides, or identical on each printer. This doesn't matter for
book designs with a white (or paper-coloured) background, but it will affect
designs where any artwork or colour extends to the page edges.

« 2times the page width
letter legal tabloid
BW/ colour BW/

« Room for bleed + trim marks
if necessary

colour colour
« Printer margins: the school printers s P 1
leave a blank border about of 0.25” ><.5 ><.5 % ? What To Do:
on all 4 edges 11" 14" 17" f
» BEST PLANNING NOT IDEAL
" g A.Design it at a small enough size C.Shrink to less than 100% size when
_' to fit on the paper with room for printing, to fit on the paper with
’’’’’’’’’’’’’’ Dlgltal Output Centre 2 printer margin, bleed, and trim bleed and crop marks
e at ks (a book at least 1inch or
DOC) Laser Printin mar
8.5" ( ) g smaller than the paper size in both  D.Accept a white border around the
pri nti ng with technicians ; width and height is safe) edge of the design. Any artwork
that should h d in that
letter tabloid tabloid extra or . . at shou av'e appeareciin tha
B.Upgrade to print on bigger paper. border space will be gone, and
8.5 11 12 13 ' 11x17" is the biggest in the self- trying to trim it off perfectly
:1" : . :8" : " serve printers, so anything that without bleed is difficult.
7 9 needs to trim down to 11x17 needs
to go to the DOC and print on
12x18" or 13x19"
: P e
DR R T
Why laser printing? B | eed
Books that digitall inted at
o0Ks .a are digrially printed & Bleed means printing a little extra beyond the edge of the page, so it can be
school will almost always be laser . . s . -
) ) trimmed off. This makes sure there aren’t slivers of white paper visible on the
printed, because the other printers )
. . edges, and allows room for error making the cut. Art that touches an outer
(inkjet or large format toner) don't print age edge must extend to the bleed line (the red line outside InDesign pages)
double-sided, and are more expensive. pag 9 gnpag
I I
6.5" Typically, the only reason to use these ——— I u — 1 -
other printers for a book project would . |
be either 1) something designed to print : |
single-sided, or 2) a book using special | :
| I
,, ,, material for a cover or insert. I l - = a =
4 47 T o | |

8"
Original File with bleed Printed and Trimmed and finished

a‘ Design ready to trim The bleed is visible on a‘
e’ the paper scraps. e,



Basic InDesign Setup

Sample Document Setup

Width
6in

Height
9in

Pages

16

Start#

1

Columns

1

Margins

Top
0.5in
Left

0.5in

Bleed and Slug
Bleed

Top
0125 in
Left

0125in

Units

Inches

Orientation

8] [&]

Facing Pages

Primary Text Frame

O

Column Gutter

0.25in

Bottom
0.5in
Right

0.5in

Bottom
0125in
Right

0125in

WIDTH & HEIGHT: The
final size of ONE page,
not the double spread.

UNITS: Inches are
easiest here, because
that matches North
American paper sizes.
It's ok to use mm or cm
if you prefer the metric
system, but don't choose
pixels (that's for screens,
not print)

FACING PAGES: On

PAGES: Should be a
multiple of 4.

COLUMNS, GUTTERS,
MARGINS: These are
guides to help with your
layout, and by default
they don't print.

BLEED: 0.125" on all
sides if you'll need to
trim the book, and O if
you don't.

Can I still change the
units later?

Yes!

- Right click the rulers at
the top and left (if the
rulers are hidden, #R
to show them), or

- InDesign >
Preferences > Units &
Increments (Mac)
Edit > Preferences >
Units & Increments
(PC)

InDesign Book Pages

i Pages
[Nane] I:I
A-Master I:I:I
-
A
1
b Y
25 T
i
2-3
% !
4-5
A Al
6-7
& Pages in 5 Spreads . W

Window > Pages

Your Pages panel should look like
this, with all the pages in spreads of
two (except the first and last, which
will join together to make the front
and back cover when you print.)

The number of pages listed at the
bottom of this window should be a
multiple of 4.

X <

¢ Pages
[None]

A-Master |:|

Letter H = ‘

h 4

Back Cover Fl'ont
Cover

A NOVEL

1

A VSO
<oy z 0 h
BT ety

< >
2 Pages in 2 Spreads . T

Separate Cover Files

It's also possible to set up covers in
their own file (and this is standard if the
cover is printed on different paper)

Here's a Pages panel from a cover
.indd file that only has two pages:

1: The outside covers (front and back.)
Note that the front cover artwork is
on the right side of the page and the
back is on the left.

2. The inside covers (a pattern image
printed all the way across.) Note:

a cover with no printing on the inside

would only need one page.
.
; e’



InDesign: Print Booklet

m Edit Layout Type (

New >
Open... ®0
Browse in Bridge... 30
Open Recent >

Folio Preview
Folio Preview Settings...

Close BW
Save ##S
Save As... {+38S
Check In...

Save a Copy... R
Revert

Place... #D
Import XML...

Adobe PDF Presets >
Export... 8E
Document Presets >

Document Setup... 3P

User...

File Info... Ll

Package... 4EP
Print Presets >
Print... ®’P

Print Booklet...

Printing booklets
from Acrobat

Acrobat also has

a booklet printing
function that works
for PDFs with single
pages, but it can
have trouble with:

% bleed + trim marks

¥ double-page
artwork going
across the fold

¥ compatibility with
the school printers

coto File > Print Booklet...

(not File > Print... as usual)

Click Print Settings at the bottom.

Print

Print Booklet

setup Setup

Summary Print Preset: |[Custom] M
Printer: 339ColourLaserPrinter
Pages: @ All

(O Range: [All Pages ~

— Booklet Type: [2-up Saddle stitch |
Space Between Pages: [+| Creep: [5]0in |

Bleed Between Pages: [+] Signature Size: )

[~ Margins
[ Automatically Adjust to Fit Marks and Bleeds

Top: Ff[0.125 in . Left: (F0.125 in
Bottom: 3012510 | Right: [£]0.125 in

[ Print Blank Printer Spreads

Print Settings... | J Print

Print Preset: |[Custom] -

rring

Printer: |339COIou rLaserPrinter

PPD: [Xerox Phaser 7700GX _ 3rdFloorPrinter s
fault Settings 3
Geners General
Setup j [gTwu—S\ded
Marks and Bleed - ™
Sut Copies: Collata [ 1
z rom: |1 to: |1
Graphics — Pages out L
Color Management "R -
Pages: (v e
Advanced 9 . Pages per Sheet: | 1 ihal
Fmme () Range: |All Pages | = = -
Sequence: = Layout Direction H pa Ifl l\l
Border: | None 3
Two-Sided: | Short-Edge binding 7|

[_| Reverse page orientation
[_| Flip horizontally

= Cancel Pri
Print Layers: |Visible & Printal D | Cancel | [Print

! Print Non-printing Objects *
Print Blank Pages
Xerox Features E
[ Print Visible Guides and
Paper/Qutput a
— Job Type: i ]
Page Setup... (@ Printer... [} Save Preset... e T—JLTLl Normal Print

Papet D 1-Sided Print

PRINT SETTINGS

General

« Choose the printer from the list

« Choose number of copies

« Print Blank Pages: on

Setup

« Choose the paper size (letter or tabloid)
« Pick a landscape (horizontal) orientation)
. Page Position: Centered

Marks and Bleed

« If you’re trimming the book, turn on Crop Marks,
and make sure Bleed is 0.125 inches

Now, click the “Printer” button...

[/ 2-sided Print

bl ., 7 2-Sided Print, Flip on Short Edge

DOUBLE SIDED (this needs to be the last step)

This can be in two different \p
locations sending to the school N

printers from a Mac: Y
. If you see “Two-Sided” front "“nt back
right away, change it to llw
“Short-Edge Binding” front t back
\p

- If not, click the dropdown that .
says “Layout”, and pick “Xerox ’\\_
Features”. Now, choose
“2-Sided Print, Flip on

Short Edge”

"Short-edge" is the correct
setting for most booklets.

It means the shorter side of the
paper is parallel to the book's spine/fold.




Preview + Print

Now, click “Print”, then “Ok”, and look at the preview. This is the shuffled order. If it
looks right and fits on your paper, it’s ready to print!

Preview

WRONG

® Does not fit on the paper
® Warning about page count
® Front + back cover (or first and last

Spread 1 of 8 - Pages(l)

Messages Warning

/b, The booklet doesn'sfitthe current paper size
3 blank pages have been added to create the Click Print Settings to specify a larger paper
booklet: see page(s) (1, 4, 5) size o1 10 scale the booklet to fit

page) not together

Preview

RIGHT

v/ Fits on the paper
v No warnings

Spread 1 of 6 - Pages(12, 1)

Messages. Warning

v Front + back cover (or first and last
page) appear together

Generate a PDF with the shuffled page order for folding:

- Go through the same Print Booklet setup (except for double-sided), and choose
"PostScript File" from the list of printers, instead of an actual printer.

. It will save a .ps file. Open the .ps with Acrobat Distiller. If you have Acrobat Pro
or Acrobat DC installed, Distiller should be in the same application folder.

- Distiller will generate a PDF. You can choose a preset, just like exporting a PDF
from InDesign, or customize a preset by going to the Settings menu, and "Edit
Adobe PDF Settings". It defaults to letter-size paper, so you'll need to adjust the
settings if you're printing on tabloid.

. If you're asked to provide a PDF with "printer spreads", this is what that means.
If the pages are in the order they're meant to be read, (as they should be in the
InDesign file) that's called "reader spreads".

How do | staple this?

With a long reach or booklet stapler!

Long reach stapler

In an emergency
without a special
stapler, you can bind
a copy with loose
staples + a pin,
needle, or awl to
make holes in the

paper.

Booklet Stapler

Rest the fold on the "hill"

« COMD studio
C3215/C3218 « COMD studio

C3215/C3218
« Visual Arts

B4130 and B4170

If you get your book printed by the DOC technicians,
the folding and stapling is done for you.

If the folded book gets too thick, the pages at the
inside center will start to stick out farther than the
pages on the outside. This is called creep.

o There is actually a setting in in InDesign’s Print
Booklet options to compensate for this, so that
the pages are shifted a little and the creep can be
[ trimmed off. Most books look neater with the front
é edge trimmed (this is called a "face trim", and it's

standard for professionally printed folding books.)

However, if your book is thick enough that creep
is a big problem, you might want to consider a
different binding method. Thick folded books are
more difficult to staple, and have trouble lying flat.

Other binding/finishing options

« Glue binding (done by  « Wire or coil binding
machine at the DOC,
or by hand by you. DIY
glue binding usually
takes some effort and
practice to get a really
nice result)

« Sewing / stab binding

» Chicago binding
(screw posts)

« Accordion fold
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